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Introduction 
 
Thank you for choosing M-Game RGB Dual powered by M-Audio! The M-Game RGB Dual is a powerful audio interface/ 
mixer/sampler/voice effects box designed for the streaming gamer. Preview samples and voice effects before you stream. 
Capture, create, edit, save, and assign samples and voice effects and customize audio routing. Match the onboard RGB 
LED colors to your build’s lighting. 

 
Information & Support 
 
For the latest information about this product (documentation, technical specifications, system requirements, compatibility 
information, etc.) and product registration, visit m-game.com. 

 
About This User Guide 
 
This manual should help you get familiar with using your M-Game RGB Dual. For consistency, the terminology throughout 
is based on M-Game nomenclature. We also used specific formatting to indicate particular topics of significance: 
 
Important/Note/Tip: Important or helpful information on a given topic. 
 
Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual. 

Examples: Press this button to switch the Main Control knob. 
      Connect speakers to the M-Game RGB Dual’s Main Out. 
      Connect media player to the M-Game RGB Dual’s Aux In. 

 
Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters. Click 
the text to skip immediately to that section. 

Examples: See the connection diagrams in the Hardware Setup section for more details. 
      Use the M-Game software to change the LED behavior of this button seen in the Microphone Settings 
      section. 

 
Software Download and Installation 
 
1. Before connecting M-Game RGB Dual to your computer(s), first download and install the M-Game software (Windows 

10, 64 bit minimum supported, and macOS 10.15 minimum supported) to any computer that will be connected to  
M-Game RGB Dual using the link on the software download card. For the latest driver compatibility details and app 
support, please visit m-game.com. 

2. Open the files you downloaded and double-click the installer file. 

3. Follow the on-screen instructions to install the M-Game software, and connect M-Game RGB Dual's Stream USB port 
to your computer. If you are using a 2-computer setup, connect M-Game RGB Dual's Stream USB port to your 
Streaming computer and the M-Game RGB Dual's Game USB port to your gaming computer. 

IMPORTANT: The M-Game software installer package installs the M-Game audio driver to your PC/macOS. If using a dual 
PC/macOS setup, any computer that will be connected to the M-Game RGB Dual will need to have the M-Game software 
installed. 

http://www.m-game.com
http://www.m-game.com
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Hardware Setup 
 
These connection diagrams show examples of how to connect your devices and computer to the M-Game RGB Dual. 
 

 

Example 1 – Streaming from a Single Computer Setup (with Optional Gaming Console) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
  
 
 
 
 
 
 

1. Connect your microphone and 
headphones, or headset to the 
rear panel of the M-Game. 

7. Connect M-Game RGB Dual 
to power and turn it on. 

4. (Optional) Connect 
media player (optional) 
to M-Game RGB 
Dual’s Aux In.  

6. Connect streaming/gaming 
computer to M-Game RGB Dual’s 
Stream USB port. 

3. (Optional) Connect a 
single (TS) or dual (TRS) 
footswitch (optional) to 
M-Game RGB Dual’s 
Footswitch input to 
activate an effect or to 
trigger samples. 

5. (Optional) Connect a gaming 
console’s or television’s Audio Out 
to the M-Game RGB Dual’s 
Console input using Optical Digital 
Audio (PCM) cable. Connect the 
console’s HDMI output to a video 
capture interface which will connect 
to your streaming computer. 

2. (Optional) Connect 
speakers to the M-Game 
RGB Dual’s Main Out. 
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Example 2 – Streaming with a Dual Computer Setup 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 
 
 
 
 

1. Connect your microphone 
and headphones, or headset 
to the rear panel of the         
M-Game. 

8. Connect the M-Game 
RGB Dual to power and 
turn it on. 

3. (Optional) Connect media 
player to the M-Game RGB 
Dual’s Aux In. 

4. Connect primary 
streaming computer to 
the M-Game RGB 
Dual’s Stream USB 
port. 

6. (Optional) Connect a single (TS) or 
dual (TRS) footswitch to the M-Game 
RGB Dual’s Footswitch input. 

2. (Optional) Connect 
speakers to the M-Game 
RGB Dual’s Main Out. 

5. Connect chat audio/gaming 
computer to M-Game RGB 
Dual’s Game USB port. 
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Software Setup 
 
Windows  
 
1. Download and install the latest M-Game software (with embedded audio driver) from            

m-game.com. 

2. Connect the power and USB cable(s) to the M-Game RGB Dual and press the   
power       button. 

3. Connect your separate headphones and microphone, or combined headset, to the 
rear panel of the M-Game RGB Dual. 

4. Open the M-Game software and select either the SET MIC from the HOME tab and 
follow the on-screen instructions or go to the SETUP   tab and select the HW 
METER button so its lit red. 

a. Under Microphone, turn Phantom Power on or off depending on whether you’re 
using a condenser microphone (Phantom Power on) or a dynamic microphone 
(Phantom Power off). 

Note: Headset microphones do not require phantom power. 

b. Speak into your mic at the loudest level you expect to speak in your stream and begin turning up the Gain knob on 
the rear panel of M-Game RGB Dual. You'll notice that the Mic Fader LEDs on M-Game RGB Dual will light up 
when you speak, showing the incoming signal. Continue speaking into the mic and turning up the Gain knob until 
you see the Mic Fader LEDs flash red 3 times. This means M-Game RGB Dual's Mic Gain knob is set too high. 
Turn down the Mic Gain knob until you no longer see the LED flash red 3 times. You’ll want to get the Mic Fader 
LEDs as close to the top LED without the LEDs all flashing. 

Note: If you are using a low gain mic (like a SHURE SM7B 
or ElectroVoice RE20) you will need to use the M-Game 
software's BOOST function. You can find BOOST in the 
Setup tab under Basic Microphone Settings. Simply 
speak into your mic at the loudest volume you expect to 
speak in your stream and turn up the Boost knob until the 
Mic fader’s meter in the M-Game Software shows the 
top LED lit red. Slowly turn the Boost knob back down 
until the Mic fader’s meter in the software no longer 
shows red. You can change the BOOST level from Off to 
+24 dB. 

Note: Now that you’ve setup your mic you can turn off the 
HW METER button in the M-Game Software to return 
the Mic fader to its default LED behavior. 

c. Adjust the EQ, Compressor, Noise Gate, High Pass Filter 
(HPF), and De-esser settings to get the best sound from 
your mic.  

Note: You can also use one of the Mic presets in the      
M-Game software to automatically configure your mic’s 
settings. These mic presets are found in File > Setup > 
Load Microphone Settings. 

5. In the SETUP tab's HARDWARE section select what source 
your Game audio is coming from and what source you Chat 
Audio is coming from. 

6. Open your game, chat, M-Game software, streaming 
software, and any other programs you will be running in your 
stream and ensure that their audio is playing 

7. Press the Windows key and then type Sound Settings into 
the search bar. Alternatively, right click the speaker icon in the 
taskbar and select Open Sound Settings. 

 

http://www.m-game.com
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8. On Windows 10, in Sound Settings, under Sound Output select System. This will 

ensure any audio that you're not routing specifically to the M-Game RGB Dual's Game, 
Chat, or Sampler fader will default to be controlled by the System fader. Under Input 
select Stream. This will set your broadcast/stream mix as your default output source. In 
Sound Settings under Advanced Sound Options, select App Volume and Device 
Preferences. In this window you will see every audio source running and where that 
audio is being sent to and from (its Routing). This allows you to send audio from different 
programs to the M-Game. 

On Windows 11, in Sound Settings under Sound Output select System. This will 
ensure any audio that you're not routing specifically to the M-Game RGB Dual's Game, 
Chat, or Sampler fader will default to be controlled by the System fader. Under Input 
select Stream. This will set your broadcast/stream mix as your default output source. In 
Sound Settings select Volume mixer. In this window you will see every audio source 
running. You will also be able to select where that audio is being sent to and from (its 
Routing) by pressing the down arrow next to the app's volume slider. This allows you to 
send audio from different programs to the M-Game. 

9. In App Volume and Device Preferences (Windows 10), and Sound and Volume mixer (Windows 11), next to the 
game that you are running, select the Output dropdown and select Game (M-Audio M-Game RGB Dual). Once this has 
been selected, your game's audio level will be controlled by the Game fader on your M-Game. 

10. Select these additional routing options from the Output 
dropdown in the App Volume and Device Preferences: 

a. Chat app (Discord, etc.): Select CHAT (M-Audio M-
Game RGB Dual) to route Chat’s audio to the Chat 
fader. 

Important: If you're using a Chat application like 
Discord, set the Audio Input to Chat and Output to 
Chat. This will ensure that your Chat audio is sent to 
the M-Game RGB Dual's Chat fader, and that your 
Mic is only sent to the Chat.  

b. Music: Select SYSTEM (M-Audio M-Game RGB Dual) 
to route music program audio to the System/Aux 
fader. 

Note: You can route additional computer audio 
sources to the SYSTEM channel if you would like to 
control additional streams of software audio. 

11. Open your streaming/broadcast software, such as OBS 
used in the example below. 

12. OBS, in the File > Settings menu, select the Audio tab. 

a. Under Global Audio Devices set Desktop Audio to 
Disabled, set Desktop Audio 2 to Disabled. 

b. Set Mic/Auxiliary Audio to STREAM L/R (M-Audio 
M-Game RGB Dual Stream). Make sure that 
Mic/Auxiliary 2, 3, and 4 are all set to Disabled. 

c. In Advanced, set Monitoring Device to Default. Click Apply and OK. 

13. Check OBS or other software you're using to record to make sure that your individual signals (Mic, Game, Chat, 
Sampler, and System) signals aren't clipping (going into the red) and are balanced. An easy way to check this is by 
pressing all of the Mute buttons on the M-Game hardware and turning up the fader levels one at a time, first checking 
the mic level, as that's what you want your viewers to hear loudest, then proceed with the other M-Game faders.  

Note: The optimal level in OBS is in the yellow area (between -15 dB and -10 dB). 

14. Start your stream and have fun! 
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macOS 
 
1. Download and install the latest M-Game software (and Audio Output Director) from            

m-game.com. 

2. Connect the power and USB cable(s) to the M-Game RGB Dual and press the                    
power       button. 

3. To use all of the features of the M-Game RGB Dual on macOS certain settings must be 
enabled in Security & Privacy settings. 

To ensure full functionality of the M-Game RGB Dual, you will need to navigate to System 
Preferences > Security & Privacy > Privacy and select the lock icon in the bottom left 
corner of the GUI. You will then be prompted to enter your System Password to make 
changes. The following items should be set to allow for M-Game software access: 

Microphone: Allow access to the M-Game RGB Dual by checking the box. 

Accessibility: Allow access to the M-Game RGB Dual by checking the box. 

Full Disk Access: Allow access to the M-Game RGB Dual by checking the box. 

Note: If the M-Game RGB Dual or M-Game software is not listed as an available option, you can manually add them 
by selecting the + icon directly beneath the App list. 

4. Connect your separate headphones and microphone, or combined headset, to the rear panel of the M-Game RGB Dual. 

5. In the M-Game software and select either the SET MIC from the HOME tab and follow the on-screen instructions or go 
to the SETUP     tab and select the HW METER button so its lit red. 

a. Under Microphone, turn Phantom Power on or off depending on whether you’re using a condenser microphone 
(Phantom Power on) or a dynamic microphone (Phantom Power off). 

Note: Headset microphones do not require phantom power. 

b. Speak into your mic at the loudest level you expect to speak in your stream and begin turning up the Gain knob on 
the rear panel of M-Game RGB Dual. You'll notice that the Mic Fader LEDs on M-Game RGB Dual will light up 
when you speak, showing the incoming signal. Continue speaking into the mic and turning up the Gain knob until 
you see the Mic Fader LEDs flash red 3 times. If you see the Mic Fader LEDs flash red 3 times, this means          
M-Game RGB Dual's Mic Gain knob is set too high. Turn down the Mic Gain knob until you no longer see the LED 
flash red 3 times. You’ll want to get the Mic Fader LEDs as close to the top LED without the LEDs all flashing. 

Note: If you are using a low gain mic (like a SHURE SM7B or 
ElectroVoice RE20) you will need to use the M-Game 
software's BOOST function. You can find BOOST in the 
Setup tab under Basic Microphone Settings. Simply speak 
into your mic at the loudest volume you expect to speak in 
your stream and turn up the Boost knob until the Mic fader’s 
meter in the M-Game software shows the top LED lit red. 
Slowly turn the Boost knob back down until the Mic fader’s 
meter in the software no longer shows red. You can change 
the BOOST level from Off to +24 dB. 

Note: Now that you’ve setup your mic you can turn off the 
HW METER button in the M-Game software to return the 
Mic fader to its default LED behavior. 

d. Adjust the EQ, Compressor, Noise Gate, High Pass Filter and De-esser settings to get the 
best sound from your mic. 

Note: You can also use one of the Mic presets in the M-Game software to automatically 
configure your mic’s settings. These mic presets are found in File > Setup > Load 
Microphone Settings. 

 

 

 

 

http://www.m-game.com
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6. In the SETUP tab's HARDWARE section select what source your Game audio is coming 
from and what source you Chat Audio is coming from. 

7. Open your game, chat, M-Game software, streaming software, and any other programs 
you will be running in your stream and ensure that their audio is playing. 

8. In the M-Game RGB Dual software go to Options > Redirect Output. 

9. In the M-Game RGB Dual software's Output Redirection you will see every audio source running in the Application 
column and where that audio can be sent to (its Routing) in the Output Pair column. This enables you to send audio 
from different programs/applications to the M-Game. 

10. In the M-Game RGB Dual Output Redirection's 
Application column you will see the game that you are 
currently running. In the Output Pair column select 
Game Out. Once this has been selected, your game's 
audio level will be controlled by the Game fader on your 
M-Game. 

11. Select these additional routing options from the M-
Game RGB Dual Output Redirection: 

a. Chat app (Discord, etc.): Select CHAT OUT to route 
Chat application’s audio to the Chat fader. 

Important: If you're using a Chat application like 
Discord, set the Audio Input to Chat and Output to 
Chat. This will ensure that your Chat audio is sent to 
the M-Game RGB Dual's Chat fader, and that your 
Mic is only sent to the Chat. 

b. Music: Select SYSTEM OUT to route music program 
audio to the System/AUX fader. 

Note: You can route additional computer audio 
sources to the SYSTEM/AUX channel if you would 
like to control additional streams of software audio. 

12. Open your streaming/broadcast software, such as OBS 
used in the example below. 

13. OBS, in the OBS > Preferences menu, select the Audio 
tab. 

a. Under Global Audio Devices set Desktop Audio to 
Disabled, set Desktop Audio 2 to Disabled. 

b. Set Mic/Auxiliary Audio to STREAM L/R (M-Audio 
M-Game RGB Dual Stream). Make sure that 
Mic/Auxiliary 2, 3, and 4 are all set to Disabled. 

c. In Advanced, set Monitoring Device to Default. 
Click Apply and OK. 

14. Check OBS or other software you're using to record to 
make sure that your individual signals (Mic, Game, Chat, 
Sampler, and System) signals aren't clipping (going into 
the red) and are balanced. An easy way to check this is 
by pressing all of the Mute buttons on the M-Game 
hardware and turning up the fader levels one at a time, 
first checking the mic level, as that's what you want your 
viewers to hear loudest, then proceed with the other      
M-Game faders. 

Note: The optimal level in OBS is in the yellow area (between -15 dB and -10 dB). 

15. Start your stream and have fun! 
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Operation 
 

Home Menu 
 
The home page shows the hardware in its current state. This gives a visual reference of the M-Game RGB Dual hardware 
when in use, and is usually the page that will be open when actively streaming.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The software toolbar at the top of the main window is used to access the File, Options, and Help dropdown menus listed 
below. 

 

File 

• Load Preset: Select to load an existing profile, which is a saved snapshot of the app. 

• Save Preset: Select to save the current app snapshot to the existing profile. 

• Setup: Select to load or save Microphone assignment settings. 

• Routing: Select to load or save virtual fader (where applicable), and active audio channels settings. 

• Sampler: Select to load or save sample button assignment settings, including button types. 

• Effects: Select to load or save effect button assignments. 

• LED: Select to load or save all LED settings. 
 

Options 

• Global: Select to either show or hide tooltips when hovering near various controls. 

• Effects: Select from the options to show the unsaved effects warning dialog box, discard unsaved effects without a 
dialog box prompt, or overwrite unsaved effects without a dialog box prompt. 

• Sampler: Select from the options to show the unsaved samples warning dialog box, discard unsaved samples without 
a dialog box prompt, or overwrite unsaved samples without a dialog box prompt. 
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Help 

• Open User Guide: Opens the User Guide. 
• Support: Select to register your product and download M-Game software. 
• Setup: Select here for articles and videos on how to setup software and connect your computer and devices to the    

M-Game RGB Dual. 
• About: Opens the About software dialog box. 

 
 

Top Bar 
      AUD indicator will be lit when the app is in Audition to Headphones mode. For additional info on Audition Mode, 

please see the Sampler and Effects sections. 

The REC indicator will be lit when the app is in Record mode. For additional info on Record Mode, please see 
the Sampler section. 

 
 

Vertical Navigation Bar 
The vertical navigation bar allows quick access to these various sections.  

• Home (default) 

• Setup 

• Routing 

• Sampler 

• Effects 

• LEDs 

 
 
 
 
 
 
 
 
 
 

Navigating via the graphic representation of the hardware on the home 
page 
Click on the various areas to navigate to these corresponding pages:   

• The SET MIC button in the top left section opens the SETUP page and 
walks you through setting up your mic. 

• The buttons in the VOICE FX section open the EFFECTS page. 

• The buttons in the SAMPLES section open the SAMPLER page. 
 

Home Page Quick-View Details 
The VOICE FX area shows the two assigned effects, and the SAMPLES area 
shows the five assigned samples in the currently selected bank.   
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Setup 
 
Microphone Settings 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. HW Meter: This button changes the Mic LED/fader on the hardware to show what the mic gain is to aid in setting the 
optimal gain level. Unticking this button or exiting the setup page will toggle back to normal mic fader mode and turn off 
the mic LED at the top of the page. 

2. Phantom Power: This toggles phantom power on or off, providing power to condenser microphones. Condenser 
microphones require phantom power. Dynamic microphones and headsets do not require phantom power.  

3. Boost: This knob adjusts the amount of digital gain applied to the incoming mic signal. If you are using a low gain mic 
(like a SHURE SM7B or ElectroVoice RE20) you will need to use the Boost knob. You can change the BOOST level from 
Off to +24 dB. Check OBS or other software you're using to make sure that your mic signal isn’t clipping.  

4. EQ (On/Off): This turns on or off the EQ settings for the incoming mic signal. 
5. EQ: This three-band equalizer helps to adjust the low, mid (with a sweepable mid frequency to boost/cut the signal to 

find the “sweet spot”), and hi frequencies to achieve a good sound mix.   

6. Compressor (On/Off): This turns on or Off the Compressor effect for the incoming mic signal. 

7. Compressor: This knob reduces the loudest parts of the audio signal and makes the quieter parts sound louder. It 
actively changes the dynamic range of the mic signal by automatically reducing its level if it exceeds a certain level. 

8. Noise Gate (On/Off): This turns on or off the Noise Gate effect for the incoming mic signal. 

9. Noise Gate: This knob can be used to reduce hum or unwanted background noise from the incoming mic signal. 

10. De-esser: This knob can be used to reduce the amount of sibilance (S, F, X, SH, and soft C’s sounds) common in 
vocals. 

11. HPF: This (High-Pass Filter) knob can be used to remove unwanted low-end rumbles. This knob is useful for removing 
the keyboard and desk impact noises. 

 

1 

2 

3 
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Mute Button 
 
The Stream, Chat, Alt, Main Out, Phones, and Sampler outputs each have an icon which can 
be toggled on or off. Toggling them on indicates that the MUTE will mute the microphone's 
signal to that output when engaged. Double pressing the Mute button on your M-Game 
RGB Dual will engage MIC MUTE ALL. This is a quick way to toggle all of them On.   
 
 
 
 
 
 
"$%^#*" (CENSOR) Button 
 
This selection enables you to select and set the sample that will be triggered 
when the "$%^#*" (CENSOR) button is pressed. When the "$%^#*" (CENSOR) 
button is pressed the selected sample will play as a one-shot and the 
microphone signal will be muted for as long as the button is pressed and held. 

 
 
 
 
 
 

 
Hardware Control Settings 
 
This section shows from what PC the Chat Audio and the Game Audio sources will be received 
from. 

Chat Audio Source: Stream PC or Game PC 

Game Audio Source: Stream PC, Game PC or Console/Television (Optical) 
 
 
 
 
 
 
 
 
 
 

 
Footswitches 

 
These can be independently set to one of two modes, M-Game or Hot Keys. 

In M-Game mode, a footswitch can be set to trigger any button on the hardware. A list of all potential hardware buttons will 
be shown. 

In Hot Key mode, a footswitch can trigger a hot key (macro/keyboard shortcut) combo. A dropdown list will be seen to 
select the key and modifier key. 

Note: When the Mic Mute button is assigned to the footswitch, double tapping the footswitch will work the same as double 
tapping the M-Game RGB Dual's Mic Mute button and will mute the Microphone's signal going to all sources. 
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Routings 
 
When the Routings tab is selected you will see what audio input signals are being sent to the different audio outputs. From 
here you can choose how the inputs and outputs are mapped. Select what audio channels you want sent to your STREAM, 
CHAT, ALT (additional USB output), SAMPLER, MAIN OUTS and HEADPHONES. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Input Icons: Each “input icon” can exist in two different modes, toggle mode and virtual fader mode. Right clicking 
(Windows) or secondary clicking (macOS) on each icon brings up a menu that can switch between the two modes. 
Secondary clicking can be changed in macOS System Preferences. 

2. Basic Mode (default): In this mode, clicking on an icon will toggle it on or off. Off icons will appear grayed out, which 
will mute that input to the corresponding output (at the end of the row). 

3. Virtual Fader Mode: In this mode, a smaller version of the icon will be shown along with a virtual fader and numeric 
level indicator. When in virtual fader mode, the input ignores the physical fader for that output and allows you to make a 
completely virtual mix to the output (at the end of the row). Using virtual faders is helpful if you would like to hear a 
different volume mix in your headphones than what is being sent to the stream. 

4. Output Icons: The Output Icons are used to represent the various USB audio outputs and hardware outputs on the     
M-Game RGB Dual. Right clicking (Windows) or secondary clicking (macOS) on each icon brings up a menu that can 
activate the following options. Secondary clicking can be changed in macOS System Preferences. 

5. Headphones: Activating this will send that outputs audio to the headphones. 
6. Basic Mode: Selecting this will change all of the icons from Virtual Mode to Basic Mode. 
7. Virtual Mode: Selecting this will change all of the icons from Basic Mode to Virtual Mode. 
8. Set All Muted: Selecting this will mute audio inputs being sent to the output. 

9. Set All Unmuted: Selecting this will unmute audio inputs being sent to the output. 

10. Copy Mixer To: Selecting this will enable you to copy and paste the audio input settings being sent to the currently 
selected output to another output. 

 

1
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Sampler 
 
Samples (1-10) 
 
This menu accesses the sample button functions. The sampler page is broken into four sections: The Sample List, the 
Sample Button Control, the Menu Bar, and the Sample Editor.  
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Sample List 
 
This is a list of the current available samples.  
 
Sample Control  
 
This gives a visual display of the hardware where you can configure the sample buttons.   
 
1. Bank Toggle: This shows a bank 

selection toggle to determine 
which bank you are affecting.   

2. Frame: When a sample has been 
assigned, these frame areas will 
show a sample’s corresponding 
image and Button Type (Play 
Mode).  

3. Name and Clear: Below each 
floating frame is the name of the 
sample. You can drag samples 
from the sample list onto a button 
or into the image frame, and it will 
associate that button with the 
sample. The image will fill the 
empty frame, the name of the 
sample will appear below, and the 
button type will appear in the small 
frame at the bottom right of the 
image. Right-click (Windows) or 
secondary click (macOS) on a 
button to bring up an option to 
clear the button. 

Note: If dragging a sample into the frame or onto the button, the sample will replace all of the samples in the current 
Stack. 

4. Selecting a button: When a new sample is dropped onto a button, it will also select that button. Click on a button to 
also select that button. When a button is selected, its settings appear in the Button Control panel. 

• To assign a sample to a button: Drag the sample from the sample list to either the frame or the representation of 
the button. This will clear all current contents for the button (except LED settings) and assign that sample to that 
button. While dragging a sample, if the mouse is over a button, you can visually see the contents of the button 
underneath before releasing the mouse and affecting a change to that button. To cancel, move the mouse off the 
button and stack areas and release to cancel the potential change. 

5. Stack: In addition to dragging samples directly onto buttons, a sample can be dragged onto the Stack list for a selected 
button. Samples can be rearranged inside of a stack by clicking and dragging. Right click on a sample in the stack list 
to pull up a menu with move up, move down, and remove options. Double click on a sample in a stack to select it in the 
editor and auto-select it in the sample list. 

6. Button Types: The sample button types are: 

• One Shot: Plays the sample one time all the way through. 

• Tap Loop / Tap Stop: Plays the sample and loops it until pressed again. 

• Tap Play / Tap Fade: Plays the sample and loops it. When tapped again it will begin to fade out.  

• Hold Play / Release Stop: Plays the sample and loops it until released, at which time it abruptly stops.  

• Hold Play / Release Fade: Plays a sample until released, at which time it begins to fade out. 

• Hold Loop / Release Stop: Plays a sample and loops it until released. 

1 
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LED Control 
 
Click to select what the button’s LED color and effect will be. 

• Solid: Keeps the LED as the selected solid color. One 
color can be selected from the list of colors. 

• Pulse: Activates the pulsing effect, which will 
brighten the LEDs and then dim the LEDs. When 
Pulse is active, the LEDs will pulse uniformly. You 
can select up to a maximum of 4 LED colors to pulse 
between. These colors will go in order from 1-4, and 
then repeat starting at 1.  

• Rainbow: Activates the rainbow effect. The button will color cycle through the entire spectrum of available LED colors. 
Selecting Rainbow will allow you to select Default for standard LED brightness, Dark 1 or Dark 2 for darker LED 
brightness or Bright 1 or Bright 2 for brighter LED brightness.  

 

Menu Bar 
 
The menu bar has basic functions that allow you to interact with 
samples. It contains basic save, save as, open, new, and delete 
functions. 
 
1. Update Sample: This works like a standard save function, where changes to the active sample are updated.  

2. Save As New Sample: This works like a standard save-as function, showing the sample and changing the name. 

3. Import Sample: This enables you to import .wav, .mp3, .wma, and .aif files into the sample editor.  

4. Record New Sample: This allows you to record a new file for editing. When recording a new sample, the record 
indicator at the top of the app will turn on. The RECORD NEW SAMPLE button will become a STOP RECORDING 
button. 

5. Remove Sample: This removes the currently active sample from the sample list. This does not delete the sample from 
your hard drive. 

 

1 2 3 4 5
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Sample Editor 

 
1. Sample Transport: The sample editor includes standard play and stop controls. The Play button will play the sample 

from the start flag to the end flag. Adjust the flags to adjust the play start and end area. 

2. Sample Visualizer: A visual representation of the sample file's audio. 

3. Selection area: A selection area in between the start and stop flag allowing for zoom in/out controls. 

4. Zoom: These + and - magnifying glass icons zoom in or out with focus (not between the beginning and ending flag), 
zooming to the middle of a selection, unless modifying zoom clicks by pressing the shift key. 

• Shift + clicking zoom in: This zooms in to the current selection (between the beginning and ending flag). 

• Shift + clicking zoom out: This zooms out to the current selection (between the beginning and ending flag). 

• CTRL + clicking zoom in and out: This returns the sample waveform editor to the current selection (between the 
beginning and ending flag). 

5. Normalize Button: This adjusts the level of the sample's gain to its maximum non-clipping level. 

6. Fader: This adjusts the level of the sample's gain. A red clip text will illuminate next to the gain fader when too much 
gain has been applied to a sample. If this occurs, lower the gain fader. 

7. Sample Frame: This image picker allows you to select an associated image. You can load .png, .jpg, .jpeg, .gif, .tif, and 
.tiff images with a size of 86x86 (standard res) or 172/172 (high-res displays). Images not formatted to the listed sizes 
will be resized to fit in the frame. 

8. Sample Title Bar: This naming field enables you to edit the name of the current sample. 

9. Audition Privately: This button will remove the sample from every output except the headphones for mid-stream 
editing purposes. When the app is in audition in phones mode, the AUD indicator at the top of the app will be 
lit. Navigating away from the page will turn off audition mode. 
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Effects 
 
Access this menu to view, assign and customize the vocal effects. The effects page is broken into four sections: The Effect 
List (Multi-Effect List), the Effect Button Control, the Menu Bar, and the Individual Effects Editor.  
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Button Control 
 
Inside the effect button control there is a visual display of the hardware where 
you can set up the effect buttons. 
 

1. Bank Toggle: This shows a bank selection toggle to determine which 
bank you are affecting. 

2. Frame: When an effect has been assigned these frame areas will show a 
voice effect’s corresponding image and Button Type (Mode).  

3. Name: Below each floating frame is the name of the voice effect. You can 
drag voice effects from the effect list onto a button or into the image 
frame, and it will associate that button with the effect. The image will fill 
the frame, the name of the effect will appear below, and the button type 
will appear in the small frame at the bottom right of the image. 

4. Selecting a button: When a new effect is dropped onto a button, it will 
also select that button. Click on a button or its image to also select that 
button. When a button is selected, its settings appear in the Button 
Control panel.  

 
Menu Bar 
 
A menu bar has basic functions that 
allow a user to interact with effects.  It 
contains basic save, save as, open, new, 
and delete functions. 

1. Update Current Effect: This works 
like a standard save function, where 
changes to the active Effect are 
updated.   

2. Save As New Effect: This works like a standard save as function, showing the Effect and changing the name. 

3. Import VoiceFX Preset: This opens a special finder type window which allows a user to search for effects library XML 
files. You can navigate to an EFFECTS library XML file which would show all potential EFFECTS that could be imported 
into the EFFECTS list. You can also select multiple EFFECTS to import using the Shift and CTRL keys. 

4. Remove Effect: Removes the currently selected Effect from the Effect list. This does not delete the effect from your 
hard drive.  

5. Audition Privately: This will remove the microphone from every output except the headphones for mid-stream editing 
purposes. When the app is in audition in phones mode, the AUD indicator at the top of the app will be lit. Navigating 
away from the page will turn off audition mode. Audition in phones overrides all mute states / live effect mode. 

6. To Broadcast: This will send the effected microphone signal to the live broadcast.  
 

LED Control 
 
Click to select what the button’s LED color and effect will be. 

• Solid: Keeps the LED as the selected solid color. One color can be selected from the list of 
colors. 

• Pulse: Activates the pulsing effect, which will brighten the LEDs and then dim the LEDs. When 
Pulse is active, the LEDs will pulse uniformly. You can select up to a maximum of 4 LED colors 
to pulse between. These colors will go in order from 1-4, and then repeat starting at 1.  

• Rainbow: Activates the rainbow effect. The button will color cycle through the entire spectrum 
of available LED colors. Selecting Rainbow will allow you to select Default for standard LED 
brightness, Dark 1 or Dark 2 for darker LED brightness or Bright 1 or Bright 2 for brighter LED 
brightness.  
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Button Type 
 
Press this to open a submenu with a Toggle and Hold selection to determine the button behavior 
when pressed. 
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Individual Effects 
 
The Effects listed in the Effects List are a creation of individual Effects settings. There are 4 individual Effect categories: 
Vocal Processor, Reverb and Echo, Chorus and Modulation, and Distortion.  
 
Each individual Effect includes an On/Off switch for that effect, a pulldown menu for effect presets/types, a Parameter knob 
for controlling the amount of the effect preset, and an ASSIGNED Button, that when selected will assign that preset effect’s 
virtual Parameter knob to the Main Control. Assigning an effect to the Main Control enables you to control the selected 
Effect parameter when the Main Control is set to FX PARAM.  
 
Vocal Processor 
 

The Vocal Processor adds harmonizing and pitch shifting, and tuning to add unique effects to 
your vocals. Adjust the virtual knob to control how much of the effect is applied from 0-
100%. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Reverb & Echo 
 

The Reverb & Echo effect adds the sense of being in a certain space, such as a hall or large 
room as well as a persistent reflection after a sound is heard. Adjust the virtual knob to 
control how much of the effect is applied from 0-100%. 
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Chorus Modulation 
 

The Chorus Modulation effect splits the sound into different parts, adding delay, panning, and 
pitch shifting to create a trembling or vibrato effect. This can be used to create a spacey or 
filtered vocal sound. Adjust the virtual knob to control how much of the effect is applied from 0-
100%. 
 

 

 

 
 
 
 
 
 
 
 
 
 
Distortion 
 

The Distortion effect produces an altered, crunchy, or harsh signal. This is usually used on guitars 
but can also be creatively used to achieve a lo-fi sound or gritty vocals. Adjust the virtual knob to 
control how much of the effect is applied from 0-100%. 
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LEDs 

 
This section allows you to adjust LED settings for any LED on the hardware. The selected LED is highlighted, and the info 
shows data about that LED (if applicable, for instance with buttons).  
 
Sample button LEDs have an extra control of UNASSIGNED, allowing you to select color and LED type for its unassigned 
state. LEDs not connected to buttons can only assign inactive or active. 
 
UNASSIGNED, INACTIVE, and ACTIVE can have three types of buttons - SOLID, PULSE, or RAINBOW. If a state choice is 
set to SOLID, there is one color picker available. When clicked on, a context menu with color swatches appears. If a state 
choice is set to PULSE, the LEDs will pulse uniformly. You can select up to a maximum of 4 LED colors to pulse between. 
These colors will go in order from 1-4, and then repeat starting at 1. If the state choice is RAINBOW, it will activate the 
rainbow effect. The button will color cycle through the entire spectrum of available LED colors. Selecting Rainbow will allow 
you to select Default for standard LED brightness, Dark 1 or Dark 2 for darker LED brightness or Bright 1 or Bright 2 for 
brighter LED brightness.  
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LED Control 
 
Solid - 1 Color: Keeps all of the LEDs lit as the 
selected solid color. 

Solid - Gradient: Keeps all of the LEDs lit as a 
spectrum of selected solid colors. You will select 2 LED 
colors to fade between.  

Pulse: Activates a pulsing effect keeping all of the LEDs 
lit as the selected colors, which will brighten the LEDs 
and then dim the LEDs. When Pulse is active, the LEDs 
will pulse uniformly. You can select up to a maximum of 
4 LED colors to pulse between. These colors will go in 
order from 1-4, and then repeat starting at 1. 

Chasing: The LEDs in will light up and dim to create the 
appearance of the LEDs moving up and down. The 
color selections will go between the 1st color chasing 
with a background color. You can select up to a 
maximum of 2 LED colors to use in Chase mode. Color 
1 will be the chasing color and color 2 will be the 
background color. 

Rainbow: The LEDs will color cycle through the entire spectrum of available LED colors. Selecting Rainbow will allow you to 
select Default for standard LED brightness, Dark 1 or Dark 2 for darker LED brightness or Bright 1 or Bright 2 for brighter 
LED brightness. 

Fader- 1 Color: Keeps all of the LEDs at and below the current Fader position lit as the selected solid color. 

Fader- 1 Color with Indicator: Keeps all of the LEDs below the current Fader position lit solid as color selection 1, with 
color selection 2 showing the current fader position. 

Fader- 1 Color with Indicator and Background: Keeps all of the LEDs below the current Fader position lit solid as color 
selection 1, with color selection 2 showing the current fader position, and all of the LEDs above the current Fader position lit 
solid as color selection 3.  

Gradient Fader- Color: Keeps all of the LEDs at and below the current Fader position lit as a spectrum of the 2 selected 
solid colors.  

Gradient Fader- Color with Indicator: Keeps all of the LEDs below the current Fader position lit as a spectrum of the 
selected solid colors 1 and 2, with color 3's selection showing the current fader position. 

Gradient Fader- Color with Indicator and Background: Keeps all of the LEDs below the current Fader position lit as a 
spectrum of the selected solid colors 1 and 2, with color 3's selection showing the current fader position and all of the LEDs 
above the current Fader position lit solid as color selection 4. 
Pulse Fader: Activates a pulsing effect keeping all of the LEDs lit below the current fader position as the selected colors, 
which will brighten the LEDs and then dim the LEDs. When Pulse is active, the LEDs will pulse uniformly. You can select up 
to a maximum of 4 LED colors to pulse between. These colors will go in order from 1-4, and then repeat starting at 1. 

Chasing Fader - 1 Color: Activates a chasing effect keeping all of the LEDs lit at and below the current fader position as 
the selected color, lighting up and dimming to create the appearance of the LEDs moving up and down. 

Chasing Fader - 1 Color with Background: Activates a chasing effect keeping all of the LEDs lit at and below the current 
fader position as the selected background color, with color 1 lighting up and dimming to create the appearance of the LEDs 
moving up and down. 

Rainbow Fader: Activates a rainbow effect keeping all of the LEDs lit at and below the current fader position as a spectrum 
of cycling LED colors. Selecting Rainbow will allow you to select Default for standard LED brightness, Dark 1 or Dark 2 for 
darker LED brightness or Bright 1 or Bright 2 for brighter LED brightness. 

VU - 1 Color: Activates the VU effect showing a metering effect on the LEDs based on the level being sent to the inputs.  

VU - 1 Color with Peak: Activates the VU effect showing a metering effect on the LEDs based on the level being sent to the 
inputs. You can select 2 LED colors, with color 1 as any input level below the peak and color 2 for Peak output level. 

Note: To increase the speed of certain LED modes, use the Main knob with the FX Param button active, but no Voice 
Effect buttons active. 
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Color Frame 
 

Press a button to open a color selection menu to set 
the sample color for the hardware control. 
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Features 
 
Top Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Headphone/Main Level Control 
 

1. Main Control: This 360° knob will adjust either the currently selected voice effect’s parameters, or the 
Headphone/Main speakers level.  

 
 

 
 
 
Mic 
 
2. Mic Level Fader: This fader controls the mic volume being sent to the USB ports, Headphone, 

and Main Outs. This is not a “gain” control. When fully lowered, it lowers the mic to its lowest 
level. 

3.  “SPEAKERS” LED Indicator: This RGB LED will light up to show that the Main Control knob 
is currently controlling the output level of the HP Out and Main Out.  

4. FX Parameter Button: Press this button to switch the Main Control knob from controlling the 
currently selected effect’s parameter and the volume level for the 1/8” HP Out and 1/8” Main 
Out. This button will light up to show that the Main Control knob is currently controlling the 
selected effect’s parameter. This button is backlit by an RGB LED. 

5.  All Streams Mic Mute LED: Illuminates when the mic audio signal has been muted to all 
streams.  

6. : This RGB backlit button can be configured to mute the mic audio signal being sent to all audio streams, the chat 
stream, or the broadcast stream. This button can have a unique audio sample assigned to it so that when this button is 
pressed it will not only mute the incoming mic signal, but also trigger a funny audio clip or beep sound. Use the          
M-Game software to configure the sample assignment and adjust the LED behavior of this button. See the Sample 
Control section for more details. 

7.  Configurable Mic Mute Button: This RGB backlit button can be configured to mute the mic audio signal being sent 
to all audio streams, the chat audio stream, the broadcast audio stream or any other stream the mic is able to be sent 
to. Use the M-Game software to configure the mute assignment, and adjust the LED behavior of this button. See the 
Microphone Settings section for more details. 

When this button is double pressed rapidly, it will activate the MIC MUTE ALL selection and activate the MUTE ALL 
MIC LED icon. This will mute the mic going to all streams (Chat and Stream). 
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Stream 
 
8.  GAME Level Fader: This fader will adjust the volume of the game audio being sent to the 

USB ports, Headphone, and Main Outs. This level will be identical to the audio that is being 
sent to the headphones unless the headphone/speaker mix is changed in the M-Game's 
software's Routing tab. 

9.  “GAME” Mute Button: This RGB backlit button will mute the game audio signal being sent 
to the USB ports, Headphone, and Main Outs. Use the M-Game software to change the 
LED behavior of this button seen in the LEDs section. By default this LED will be brightly lit 
when Mute is active and dimly lit when mute is inactive.  

10.  CHAT Level Fader: This fader will adjust the volume of the chat audio being sent to the 
USB ports, Headphone, and Main Outs. This level will be identical to the audio that is being 
sent to the headphones unless the headphone/speaker mix is changed in the M-Game's 
software's Routing tab. 

11.  CHAT Mute Button: This RGB backlit button will mute the chat audio signal being sent to the USB ports, 
Headphone, and Main Outs. Use the M-Game software to change the LED behavior of this button seen in the LEDs 
section. By default this LED will be brightly lit when Mute is active and dimly lit when mute is inactive.  

12.  SAMPLER Fader Level: This fader will adjust the volume of the sampler audio being sent to the USB ports, 
Headphone, and Main Outs. This level will be identical to the audio that is being sent to the headphones unless the 
headphone/speaker mix is changed in the M-Game's software's Routing tab. 

13.  SAMPLER Mute Button: This RGB backlit button will mute the sampler audio signal being sent to the USB ports, 
Headphone, and Main Outs. Use the M-Game software to change the LED behavior of this button seen in the LEDs 
section. By default this LED will be brightly lit when Mute is active and dimly lit when mute is inactive.  

14.  System/AUX Level Fader: This fader will adjust the volume of the system and AUX input audio being sent to the 
USB ports, Headphone, and Main Outs. This level will be identical to the audio that is being sent to the headphones 
unless the headphone/speaker mix is changed in the M-Game's software's Routing tab.  

15.  System/AUX Mute Button: This RGB backlit button will mute the system audio and AUX signal being sent to the 
USB ports, Headphone, and Main Outs. Use the M-Game software to change the LED behavior of this button seen in 
the LEDs section. By default this LED will be brightly lit when Mute is active and dimly lit when Mute is inactive. 

 
Banks 

 
16. Bank: Toggles between the 2 Sample and Effect banks. The total amount of samples per bank is 5, for 

a total of 10 samples. The total amount of voice effects per bank is 2, for a total of 4 voice effects.   
When this button is pressed and held, the Sample buttons can be pressed to delete the currently 
assigned sample. When the Sample buttons are in delete mode, press one to remove the current 
sample(s) assigned to that button. 

 

Voice FX 
 

17. VOICE FX 1-2: Triggers a voice effect which can be assigned in the M-Game software 
seen in the Effects section.  

 

 

Samples 
 
18. SAMPLE 1-5: Press these to trigger an assigned audio sample from 

the M-Game software. 

When one of these buttons is pressed and held and no sample is 
assigned to the button, it will trigger the M-Game software to start 
recording a sample from the incoming audio signal. The audio sent to 
the Sampler can be configured via the M-Game software and seen in 
the Sampler section. 

8
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Rear Panel 
 

1. GAIN: Controls the XLR In or Mic In gain. Input gain is 
controlled using the mic Gain knob. To set the input gain 
correctly, use the M-Game software's Set Mic seen in the 
Software Setup section. 

2. XLR IN: Connect an XLR microphone here.  
If your mic requires phantom power, turn on +48V phantom 
power from the M-Game software.  

3. MIC IN: Connect a gaming headset mic to this input.  
If a TRS input is connected, this overrides the XLR mic input.  

Input gain is controlled using the mic Gain knob. 

To set the input gain correctly, use the M-Game software's Set Mic seen in the Software Setup section. 

4. HP OUT: Connect headphones to this output.  
5. MAIN OUT: Connect speakers to this 1/8” (3.5 mm) stereo TRS output. 
6. AUX IN: Connect an MP3 player or smartphone to this 1/8” (3.5 mm) stereo Aux input. 
7. FOOTSWITCH: Connect a 1/4” (6.35 mm) TRS non-latching momentary dual footswitch or TS 

single footswitch here to assign a function in the M-Game software, such as triggering mute or 
activating an effect or a sample.  

8. CONSOLE: Connect a gaming console or television here that uses an Optical Digital Audio 
(PCM type) output to capture and stream its audio. 

9. GAME USB: Connect a secondary gaming/chat computer here to send and receive M-Game 
RGB Dual’s game audio or chat audio.  

10. STREAM USB: Connect your streaming computer here to capture and stream audio from M-Game RGB Dual's 
microphone inputs, game audio, chat audio, and the aux input using the M-Game software. 
Important: Use this connection when streaming with a single computer setup. 

11.  Power Input: Connect the included power adapter here to power M-Game RGB Dual.  

12. POWER: Turns M-Game RGB Dual on or off.  

 

1/4” (6.35 mm) 
TS 

 

1/4” (6.35 mm) 
TRS 
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Appendix 
 
LEDs 
 
Fader and Main Knob 

Colors 127 

LED Modes Solid 1 Color 
Solid Gradient 
 
Pulse 1 Color 
Pulse 2 Colors 
Pulse 3 Colors 
Pulse 4 Colors 
 
Chasing 1 Color 
Chasing 1 Color with Background 
 
Rainbow Dark 1 
Rainbow Dark 2 
Rainbow Default 
Rainbow Bright 1 
Rainbow Bright 2 
 
Fader 1 Color 
Fader 1 Color with Indicator  
Fader 1 Color with Indicator and Background 
 
Gradient Color 
Gradient Color with Indicator  
Gradient Color with Indicator and Background 
 
Pulse Fader 1 Color 
Pulse Fader 2 Colors 
Pulse Fader 3 Colors 
Pulse Fader 4 Colors 
 
Chasing Fader 1 Color 
Chasing Fader 1 Color with Indicator  
 
Rainbow Fader Dark 1 
Rainbow Fader Dark 2 
Rainbow Fader Default 
Rainbow Fader Bright 1 
Rainbow Fader Bright 2 
 
VU 1 Color 
VU 1 Color with Peak 
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Accent LEDs 

Colors 127 

LED Modes Solid 1 Color 
Solid Gradient 
 
Pulse 1 Color 
Pulse 2 Colors 
Pulse 3 Colors 
Pulse 4 Colors 
 
Chasing 1 Color 
Chasing 1 Color with Background 
 
Rainbow Dark 1 
Rainbow Dark 2 
Rainbow Default 
Rainbow Bright 1 
Rainbow Bright 2 
 

 
 
Button and Label LEDs 

Colors 127 

LED Modes Solid  
 
Pulse 1 Color 
Pulse 2 Colors 
Pulse 3 Colors 
Pulse 4 Colors 
 
Rainbow Dark 1 
Rainbow Dark 2 
Rainbow Default 
Rainbow Bright 1 
Rainbow Bright 2 
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Voice Effects 
 
Vocal Processor 

Pitch Correct + Vibrato Octave Up

Sci Fi Villain  Octave Down

Alien High Fixed 

Robot 1 Low Fixed

Robot 2 Unison

Robot 3 Group 1 

Hi RPM Group 2

Wobbley Lock Tune 2 

Tiny Harmonies 1 

Male Harmonies 2

Female Harmonies 3

Child Smooth Harmonies 

Ogre  Low Harmonies

Squirrel  Bent Choir 

Octave Up Deep Choir 
 

 
 
 

Distortion 

Telephone 

Megaphone 

Walkie Talkie 

Edgy 

Drive 

Mild 

Dirt 

Awful Grungy 

Face Melter 

Intimate 

Presence 

Tiny  
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Chorus & Modulation 

Mono Tone 

Lock Tune 

Pitch Correction 

Doubler 

Wide Doubler 

Trio 

Hive 

Warbler 

Deep Flange 

Wide Flange 

Case 

What Physician 

In the Pipe 

Trembling Tremolo 
 

 
 
 
 
 
 
 
 

Reverb & Echo 

Small Room 

Medium Room 

Large Room 

Pop Vocals 

Tight Space 

Plate 

Hall 

Cathedral 

Stadium 

Cavern 

Short Slap 

Long Slap 

Echo Fast 

Echo Slow 

Helmet 
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Technical Specifications 
 
All specifications are measured at 20 kHz bandwidth. Specifications are subject to change without notice. 
 
 

Main or Headphone Outputs (unbalanced 1/8” TRS) 

Power Output 42 mW RMS (per channel into 32 Ω)  

Dynamic Range 113 dB (A-weighted) 

Frequency Response 20 Hz – 20 kHz (+0.1/-0.2 dB) 

THD+N 0.005%, 1 kHz, 10mW (per channel into 32 Ω) 

Max Output Level +6.0 dBu (unloaded) 

Output Impedance 10 Ω 
 
 
Mic Input (balanced XLR) 

Frequency Response 20 Hz – 20 kHz (+0.4/-1.8 dB) 

Signal-to-Noise Ratio 109 dB (1 kHz, +4 dBu, A-weighted) 

Dynamic Range 110 dB (A-weighted) 

THD+N 0.0015% (1 kHz, +4 dBu, -1 dBFS) 

Max Input Level +5 dBu 

Sensitivity -54 dBu 

Preamp EIN -130 dBu 

Gain Range 59 dB 
 
 
Mic Input (unbalanced 1/8” TS) 

Frequency Response 20 Hz – 20 kHz (+0.4/-1.9 dB) 

Signal-to-Noise Ratio 105 dB (1 kHz, +4 dBu, A-weighted) 

Dynamic Range 109 dB (A-weighted) 

THD+N 0.0033% (1 kHz, +4 dBu, -1 dBFS) 

Max Input Level +5 dBu 

Sensitivity -54 dBu 

Preamp EIN -127 dBu 

Gain Range 59 dB 
 
 
General 

Power 6V DC, 2A 

Dimensions  
(width x depth x height) 

10.74” x 6.6” x 2.64” 

27.27 x 16.76 x 6.7 cm 

Weight 2.88 lbs. (1.31 kg) 

 
 

Trademarks and Licenses 
 
M-Audio is a trademark of inMusic Brands, Inc., registered in the U.S. and other countries. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

macOS is a trademark of Apple Inc., registered in the U.S. and other countries. 

All other product or company names are trademarks or registered trademarks of their respective owners. 
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